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Notice to Users
EasyRecovery™ is a software application that has been developed, licensed and copyrighted by
ONTRACK Data International, Inc. Use of the software is governed by the terms and
conditions of the end user license agreement contained within the software.

This manual should not be construed as any representation or warranty with respect to the
software named herein. Occasionally, changes or variations exist in the software that are not
reflected in the manual. Generally, if such changes or variations are known to exist and affect
the product significantly, a release note or README file will accompany the User's Guide and/
or the distribution CD-ROM, or will be available with EasyUpdate downloads. In that event,
please read the release notes or README file before using the product.

Trademarks
McAfee is    a trademark of Networks Associates, Inc. in the United States and
other countries.

Ontrack, EasyRecovery, Remote Data Recovery, Crisis Center and EasyUpdate are trademarks
or registered trademarks of ONTRACK Data International, Inc. in the United States and/or
other countries.

All other trademarks used herein are the property of their respective owners.

Copyrights
© 2003 Networks Associates Technology, Inc. All Rights Reserved. 

No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language in any form          or by any means,without the written 
permission of Networks Associates Technology, Inc., or affiliate companies. 

Printed in the USA
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ABOUT THIS MANUAL

This manual uses a number of conventions that make it easier to read and
understand.

� This font denotes button and field names.

� This font denotes menus and menu paths.

� This font denotes file names, such as C:\my documents\newfile.

1. You will see this 123 graphic any time there are numbered steps or
instructions.

The term “click,” as in “Click Next to continue” means that you move the
mouse pointer over the specified area on your screen, and click with the left
mouse button.

The term “right-click,” as in “Right-click on the tray icon” means that you
move the mouse pointer over the specified location and click the right mouse
button.

Notes contain additional information that may not directly relate
to the current text, but is important to know.

Warnings contain important information that you must be aware
of to avoid possible system problems.
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The term “drag-and-drop” means that you should select an item with the
mouse, and then press and hold down the mouse button while you drag the
item to its new location.
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GETTING HELP

THIS MANUAL

This manual will get you started installing and using EasyRecovery. It
provides an introduction and explanation of the tools in EasyRecovery, and
describes how to use each one.

ONLINE HELP

The EasyRecovery online help system is available in the following ways:

� From the Help menu, select Help Topics.

� Press the F1 button.

� In any dialog box, click on the Help button.
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MCAFEE WEB SITE

At the McAfee Web Site, you can send e-mail to our customer support
team or order other McAfee products.

us.mcafee.com

TECHNICAL/CUSTOMER SUPPORT

For technical support, please visit

 http://www.mcafeehelp.com/. Our support site
offers 24-hour access to the easy-to-use Answer

Wizard for solutions to the mos
common support

 questions.
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Chapter 1: Welcome to
EasyRecovery

WELCOME TO EASYRECOVERYTM DATA

RECOVERY SOFTWARE!

EasyRecovery™ data recovery software will help you quickly and easily
recover lost or inaccessible data.

It can help recover lost data when a drive has been:

� Hit by a computer virus

� Formatted or fdisked

� Accidentally deleted

� Damaged by a power failure or power surge

� Damaged due to rogue applications or system malfunction

EasyRecovery can help if you have corrupt or missing:

� Master Boot Record (MBR)

� BIOS Parameter Blocks (BPB)

� Partition Tables

� File Allocation Tables (FAT) (for DOS/Win95/98/Me)

� Root Directory

EasyRecovery is NON-DESTRUCTIVE and READ-ONLY. It will not put
any data onto the file system (volume) it is recovering from. It will recover
your data and copy it to another destination—a removable drive, another hard
drive, a floppy diskette or a network volume.

TM
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TM

 Personal Edition User’s Guide
EasyRecovery is easy to use. The software’s fully automated wizard will
walk you through three simple steps:

1. Evaluate – the software identifies all devices and partitions on the
system and presents a graphical representation of what was found.

2. Recover – the software examines the file structures that remain on
the corrupted partition and constructs a virtual file system in
memory with them.

3. Tag and Copy – a list of files is graphically presented. You then
select (tag) files and folders for backup and move the data to a safe
location.

EasyRecovery Personal Edition runs in Windows 95, 98, and Me. It also
includes a program to create an emergency boot diskette that runs in DOS, so
you can recover data even if you cannot boot to Windows.

ABOUT THIS GUIDE

This User’s Guide and the online help files will help you with the data
recovery process. See Chapter 4, Important Terms, on page 33 for definitions
of terms used throughout this manual.

Be aware of strange noises coming from your hard drive, as this
might be an indication of a more serious problem. Continuing to
operate your system may damage your hard drive beyond
repair or cause irretrievable data loss. We recommend
performing a disk drive diagnostic (included with
EasyRecovery) before attempting to recover any data. If you
need additional help see “Technical Support and Data Recovery
Services” on page 15 for contact information.
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Chapter 1:  Welcome to EasyRecovery
DATA RECOVERY BASICS

While it can pull up files that have been inadvertently deleted from your
computer, EasyRecovery is more than a simple file undeleter. Even if your
computer has severe file system corruption, EasyRecovery can locate, recover
and restore your data.

When you delete files from your computer, they’re not really gone forever.
Traces of structural information are left behind on the disk itself.
EasyRecovery uses sophisticated pattern recognition technology to put the
right pieces of data together again. EasyRecovery finds those traces and
rebuilds them based on their statistical properties. It then builds a virtual file
system in memory and displays all the files, folders—even whole partitions—
it finds. Even systems with very little information can still be successfully
recovered.

SUPPORTED FILE SYSTEMS

EasyRecovery can retrieve data from these file systems:

EasyRecovery can also retrieve data from IOmega Zip and Jaz removable
disks.

Operating System File Systems Used

PC Floppy disks FAT12

DOS FAT16 only

Windows 3.x FAT16 only

Windows 95/98/Me FAT16 or FAT32
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SYSTEM REQUIREMENTS

EasyRecovery has the following minimum system requirements:

� 486 or Pentium-class processor

� An IDE hard drive

� 8 MB RAM (16 MB recommended)

� DOS, Windows 3.x, 95, 98, Me, NT or 2000.

� 5 MB of free space (Windows version only)

INSTALLING EASYRECOVERY

WINDOWS VERSION

Follow these steps to install EasyRecovery:

1. Insert the EasyRecovery compact disc into your CD-ROM drive.

The installation program will start automatically. If the
installation does not automatically begin, click the Start menu and
select Run. In the text box, type D:\setup.exe (where D: is the
letter of your CD-ROM drive), and click OK.

OR

If you downloaded EasyRecovery from the Internet, open
Windows Explorer (or My Computer), locate and double-click the
downloaded file. The installation process will automatically begin.

EasyRecovery Personal Edition will only recover data from FAT
partitions in Windows NT or 2000. If you have a damaged NTFS
partition, you need the Professional Edition of EasyRecovery to
recover data from it.
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Chapter 1:  Welcome to EasyRecovery
2. Follow the on-screen instructions.

After you specify an installation directory, the EasyRecovery files are copied
to your disk drive. If you have an Internet connection, we recommend you
check for any updates using EasyUpdate.

DOS VERSION

Boot your computer using the EasyRecovery Emergency Boot Diskette and
the software will automatically load. We recommend you have the destination
drive (the place where you want to copy your data to) ready and configured
before running EasyRecovery.

MAKING AN EMERGENCY BOOT DISKETTE

Once you’ve installed EasyRecovery for Windows on a working system, you
have the ability to create an emergency boot diskette should you need it in the
future. The diskette will allow you to run EasyRecovery software even if you
cannot boot to Windows. Should the partition on which EasyRecovery is
installed become damaged in the future, you can use this disk to recover data
from that partition. To make an emergency boot diskette, follow these steps:

1. Put a blank, formatted 3.5” floppy disk in the A: drive. If there is
data on the disk, it will be deleted.

2. From Windows, select Start�Programs�
EasyRecovery�Make Emergency Boot Diskette

3. Follow the prompts to start the process. Click OK to begin making
the disk.

You should not install EasyRecovery on the partition you are
trying to recover (doing so may result in overwriting recoverable
files). If your system has one drive with one partition, or if the
system is not bootable, use the DOS version of EasyRecovery.
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4. A progress bar will appear, telling you that the files are being
copied. You can click Cancel to stop the process.

5. When all the necessary files have been copied to the floppy disk, a
new window will come up. Click Exit to return to Windows.

6. Label the disk EasyRecovery Emergency Boot Diskette.

7. To test the disk, shut down your computer. Turn it back on. You
should see an EasyRecovery screen instead of Windows.

UPDATING YOUR SOFTWARE (EASYUPDATETM)

McAfee periodically improves EasyRecovery software—adding features
and making changes based on customer requests. Programming updates (also
known as patches) are also available to you through the Internet.

EasyUpdateTM downloads and installs program patches in minutes.

If there are multiple components for updating, EasyUpdate provides you with
a list of options—you can update everything, or select a subset of options.

We recommend running EasyUpdate as soon as you purchase and install
EasyRecovery, just in case there is a program patch that was not included with
your version.

To run EasyUpdate:

1. Make sure you are connected to the Internet. If you access the
Internet using a modem, you should already be dialed in, or your
browser should be set up to automatically dial in.

2. Start EasyRecovery.

3. From the EasyRecovery Welcome screen, go to the EasyUpdate
menu and select Check for Update.

4. In the EasyUpdate window, click Next to continue.

This connects you to the McAfee update server. You will see a
list of the items available for download. Selected items will be
downloaded to your computer.
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Chapter 1:  Welcome to EasyRecovery
5. Continue to follow the instructions to download and then install the
new software.

6. When finished, click Done to exit EasyUpdate.

You may be prompted to restart Windows. Once you restart
Windows, the changes will appear the next time EasyRecovery
runs.

REMOVING EASYRECOVERY

To remove EasyRecovery:

1. Make sure the program is closed.

2. From Windows, select Start �Programs�
EasyRecovery �Uninstall EasyRecovery.

3. Confirm your decision by clicking Yes, remove EasyRecovery.

TECHNICAL SUPPORT AND DATA RECOVERY

SERVICES

For technical support, please visit

 http://www.mcafeehelp.com/. 

Our support site offers 24-hour access to the easy-to-use Answer

Wizard for 
solutions to the most common support

 questions.
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In cases of severe data loss damage, you can also consult with Ontrack data
recovery representatives by calling the following numbers 24 hours a day.
The fees for these services are additional.

U.S./Canada 1-888-685-2658

U.K./Germany/France 00 800 10 12 13 14

Japan +81 (0)42-932-6365
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Chapter 2: Evaluating Your System
and Recovering Data

STEP ONE: EVALUATING YOUR SYSTEM

The first step in recovering your data with EasyRecovery is to identify and
evaluate your system. Some of this is done automatically, but you will need to
confirm some information about your computer before the recovery begins.

SELECTING THE PARTITION TO RECOVER

When EasyRecovery loads, you’ll see the Welcome screen. Click Next to
display the System Overview page. You’ll see your hard drive(s) and
removable drive(s) in the window, with all partitions listed underneath. If
there’s a floppy disk in the drive, it will also be listed.

EasyRecovery can do a quick scan of your drive to determine whether data is
immediately recoverable. Go to File�Disk Diagnostic to scan your drive.
The next section, “Disk Diagnostic,” covers this feature in detail.
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Click on the partition where the data you want to recover is located and then
the Next button to continue. If the partition you want to recover is not listed,
select any partition listed under the “right” physical drive. That is, if you want
to recover the D partition on your first hard drive, and you see just one
partition, select it. If EasyRecovery detected the file system type correctly,
this will take you to the Partition Information screen. If the file system type
was “unknown,” this will take you to the Partition Finder screen (See
“Changing the Partition Information (Partition Finder)” on page 20).

EasyRecovery cannot recover data from a removable drive
attached to a USB (Universal Serial Bus) port. Your
EasyRecovery Emergency Boot Diskette will not work if this type
of drive is damaged.
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DISK DIAGNOSTIC

EasyRecovery can bail you out of the most common data loss problems, but
occasionally a drive has become so severely damaged that you need more
sophisticated techniques to get your data back. EasyRecovery’s Disk
Diagnostic can tell you where you stand even before you’ve started the
recovery process.

Go to File�Disk Diagnostic from the System Overview screen to scan your
hard drive. EasyRecovery will look for damaged sectors on the drive for 90
seconds. If it finds more than 10 bad sectors during that scan, it is very likely
you will need professional data recovery services. If your computer fails the
diagnostic, see “Technical Support and Data Recovery Services” on page 15
for round-the-clock data recovery service phone numbers.

When the diagnostic is complete, click Back to return to System Overview.

DEFINING THE PARTITION

EasyRecovery uses information from the master boot record, any extended
boot records and BIOS parameter blocks to identify the size, file system, and
starting and ending sectors of the partition you want to recover.

In general, unless you are certain that something in the Partition Information
screen is wrong, clicking the Next button is the appropriate thing to do.
Situations where you should manually change the settings include:

� If you know what your file system is, and EasyRecovery reports it as
something else. If EasyRecovery cannot identify the file system, you’ll
be taken directly to the Change Partition Information screen.

� If the partition size is substantially different from what you know to be
true. That is, if you know you have an 8 gigabyte drive with just one
partition and EasyRecovery only sees 2 gigabytes.

� If you have recent information on the starting or ending sector of the
partition that is different from what EasyRecovery reports.
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If EasyRecovery has correctly identified the partition and its size, just click
Next to begin the recovery scan. You can also skip to “Step Two: Recovering
Your Data” on page 23.

If the information displayed is not correct, click the Change button to
correctly identify the partition to be recovered. See “Changing the Partition
Information (Partition Finder)” on page 20.

CHANGING THE PARTITION INFORMATION (PARTITION

FINDER)

When you click the Change button from the Partition Information screen, you
use the Partition Finder to manually configure where EasyRecovery should
search for your missing or damaged file system. This is meant to save you
time and is used only as an approximation. EasyRecovery will search this
area exhaustively for your file system.

There are two parts to the Partition Finder: identifying the region to search,
and identifying the file system. These are explained further in the next two
sections. These tools give EasyRecovery the minimum information it needs
to locate and recover your data.

If EasyRecovery cannot identify the file system based on the information it
finds on the drive, you will also see this screen. EasyRecovery cannot
complete a scan unless it knows how the partition is organized. If you don’t
know what file system the partition uses, there is no harm in guessing. Use the
Supported File Systems table on page 11 to help you decide. If EasyRecovery
cannot locate any files, it will simply send you back to this screen to try again.
Your files will not suffer any further damage.
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Chapter 2:  Evaluating Your System and Recovering Data
SETTING THE STARTING AND ENDING SECTOR

The first Partition Finder screen asks you to define where to search for the
start or end of a partition. By default, it will search the entire drive.

This screen offers a slider bar to reset the sector information. Just drag the left
end to the right to adjust the Starting Sector. Drag the right end to the left to
adjust the Ending Sector. You can also type this information in yourself.
EasyRecovery will search between the specified sectors to locate the partition
on the drive.

Click Next to identify the file system. Click Back to return to the Partition
Finder screen without saving your changes.

IDENTIFYING THE FILE SYSTEM

EasyRecovery uses information from the master boot record, any extended
boot records and BIOS parameter blocks to identify the file system. If that
information is faulty or unavailable, EasyRecovery will report the File System
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Type as Unknown. If EasyRecovery misidentifies the file system, you can
also click the drop-down File System Type menu here.

Before EasyRecovery can analyze the partition for recoverable data, you must
select a file system.

When you’ve made your changes, click Next to confirm the changes and
begin the recovery scan. EasyRecovery will first re-identify the partition,
then scan the drive. Depending on your system’s speed, the size of your drive
and the amount of work EasyRecovery has to do, this can take from a few
minutes to several hours.

If you want to restore the default settings, click the Back button. Click
Cancel to return to the Partition Information screen.

RAW SCAN

The RAW scan will recover files without any file system structure
information. If you’ve only recovered some files, but still need some files that
EasyRecovery did not locate on the first pass, you can also select the RAW
format. This scan will read all sectors on the disk sequentially (sector-by-
sector).

This scan will only recover small files that are stored in one cluster or larger
files stored in consecutive clusters on the disk. If you have used a disk
defragmenter recently, your chances of recovering files from a badly damaged
disk are much improved.

DO NOT attempt to defragment a damaged partition before
using EasyRecovery. If your File Allocation Table is bad,
defragmenter the partition could make your files unrecoverable.
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STEP TWO: RECOVERING YOUR DATA

Once you’ve selected and defined your partition, EasyRecovery will scan it
and recover as many files as possible.

While EasyRecovery is scanning the partition, it will give you a continuous
progress report. You’ll see:

� The current block being processed

� A running Time Elapsed/Time Remaining count

� The total number of Folders and Files Found

� The last file found (with size information)

� A progress bar showing the percentage of the scan that is complete
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You can hide this display (except for the progress bar) by clicking the Hide
Progress Details button on the right side. This will improve the performance
by decreasing the amount of work that must be done to update the screen.

You can stop the recovery in mid-process by clicking the Cancel button at the
bottom. You’ll be given a choice to save the recovery information up to that
point (see the next section, “Saving Recovery Data”), or continue the
recovery process. To get the best results, we recommend that you allow the
recovery scan to complete.

When the recovery process is complete, you can locate and recover your files.

SAVING RECOVERY DATA

If for some reason you need to interrupt the data recovery process,
EasyRecovery lets you save all the information it has retrieved from the
damaged system and pick up where you left off at some later point. This
includes the information on your partition and on any files that have been
recovered.

The easiest way and best time to do this is after the recovery is complete.
From the main Copy screen, click File�Save Recovery. You’ll be asked to
name the file and specify a folder to put it in. Since the resume feature
searches specifically for a recovery information file with a .DAT extension,
it’s a good idea to name the file in that way. For example, save the file as
Recovery.dat or SavedData.dat.

If you need to interrupt the recovery process, you’ll also get the chance to
save the recovery. For best results, however, we recommend always allowing
the recovery scan to complete.

When you want to return to EasyRecovery, follow these steps to pick up your
recovery where you left off:

1. Open the software.

2. Go to File�Resume Recovery.
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3. A dialog box will come up. Navigate to the folder where you saved
the data and double-click on the *.DAT file. You may see a
“please wait” screen while the data reloads.

4. You’ll be returned to the same screen you were at when you saved.
If a scan was in process, it will resume there automatically, using
the same parameters you set earlier.
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Chapter 3: Copying Recovered Files

STEP THREE: TAGGING AND COPYING YOUR FILES

Once EasyRecovery has recovered your data, you can then choose to copy
any or all of your files to a safe location.

LOCATING AND TAGGING FILES AND

DIRECTORIES

When the recovery is complete, EasyRecovery will show the contents of the
virtual file system in a window that looks like a file manager. Everything in
this window has been recovered from the damaged partition, and can be
copied to a safe place.

On the left side you can see the directories and subdirectories, under “My
Drive.” On the right side are the files of the selected directory.
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If your root or any directory was destroyed, EasyRecovery will create
fictitious directory names. The names with be of the form dir99999 and are
referred to as "check dirs." This is done in an effort to keep the directory tree
intact. The files that were located in these damaged directories are placed in
these check dirs. Whether or not there is a "real" name for the directory, the
files are still of the same quality.

Use this screen to select the files you want to retrieve from the disk.

TAGGING FILES

Once you’ve generated the list of files that can be recovered, you tag files to
mark them for copying. Simply check the box next to any file to tag it.

If you want to retrieve the whole partition, tag My Drive by clicking the box
on the left. A check mark will appear in the box next to all files and folders
tagged for copy. If the check is gray in color, the folder has at least one file
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somewhere below it that is tagged. If the check is blue, all files and
subfolders are tagged.

As you tag files, EasyRecovery will report the number of tagged files and
their size. The more files you tag, the longer it will take to copy them.

When you’ve tagged all the files you want to recover, click Next to complete
the process.

SETTING THE DESTINATION FOLDER

EasyRecovery copies your file(s) to a folder on an undamaged partition. The
default is C:\Recover, but if your C drive has been damaged, you must copy
the recovered files to a different partition, preferably a completely different
physical drive. This could be another physical hard drive, a network drive, a
Zip or other removable drive, or even a floppy (for a few small files).

To change the destination folder, select the text in the Copy Files To box and
type in the new folder path.

VIEWING THE CONTENTS OF A FILE

EasyRecovery will let you view the contents of a recovered file in
hexadecimal format. Select a file from the window and choose View
Contents from the File menu.

If you have more than one damaged partition on your system,
DO NOT copy files from one partition to another damaged
partition. Always use removable media (like a Zip disk) or a
second, undamaged hard drive, as the destination in these cases.
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This is shown in Byte view: you see a series of columns of binary numbers
followed by a wider 16-character column that contains some readable ASCII
text. These are the contents of a single sector. At the bottom of the screen
you’ll see the File Block address for this file. You can press Ctrl-G (or choose
GoTo Sector/Block from the View menu) to select a different sector to look
at.

The Find feature will locate a specific ASCII text string and can help you
determine if a particular critical document is still present on the disk. Let’s
say your spreadsheet with the payroll records of your company has been lost.
Follow these steps to determine if this spreadsheet is still on the drive:

1. Open the File Viewer.

2. Select Find from the Edit menu (or press Ctrl-F).

3. Type John Doe in the Find What box. Click Find Next.

4. A Searching… box will come up and tell you what sector is being
searched. This may take some time. You can cancel the search at
any time by clicking the Cancel button.
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5. If the first match for John Doe isn’t from the spreadsheet, press F3
(or go back to the Edit menu and select Find Next) to keep
looking.

Keep in mind that if a file takes up more than one sector (anything larger than
16 KB on a FAT32 system), there is a possibility that the whole file cannot be
recovered. If the FAT is corrupt, and the file is fragmented (not in contiguous
sectors), EasyRecovery may not be able to locate some parts of the file.

ASSESSING THE QUALITY OF A FILE

The condition of recovered files depends on the overall condition of the
system. EasyRecovery notes any problems with each file in the Condition
column on the recovery screen with a letter/color combination. The key is in
the chart below.

Chances are good that files flagged with a black letter in the Condition
column can be copied successfully. Deleted (blue) files have a fair chance,
and files with a red flag are poor candidates for successful recovery.

If a file has multiple problems, the color will reflect the most serious problem.
So a deleted file with a bad attribute will be blue, but a deleted cross-linked
file will be red.

Black d File with a bad date: after today or with invalid values (e.g., 15-50-2000)

Black a Bad (undefined or invalid) attribute

Black n Bad name: has invalid characters

Blue D Deleted

Red X Invalid chain, perhaps a cross-linked file or runlist that doesn’t match its size

Red s Bad size: file is larger than the partition (volume)
Page 31



EasyRecovery
TM

 Personal Edition User’s Guide
COPYING FILES TO A SAFE LOCATION

When you’ve tagged your files and selected a target folder, you’re ready to
begin moving data. Click Next to begin.

EasyRecovery will copy the data to the destination folder. The more files you
have tagged, the longer the copy process will take. If you have tagged more
than a few small files, you’ll see a screen similar to the Recovery Scan screen.
It will give you a continuous progress report, with the file being recovered,
the destination and the Time Elapsed and Remaining. A progress bar will also
keep you posted on the percentage of files copied.

By default, EasyRecovery will deliver a report on the files you copy. This
time-stamped report contains the location of your recovered file(s), the date
each file was last modified, and its size. You’ll also get the total number of
files, and bytes, recovered.

When your files have been copied to the destination folder, click Finish to
close EasyRecovery.
Page 32



Chapter 4:  Important Terms
Chapter 4: Important Terms

CLUSTER

The basic unit of data structure on a hard or floppy drive. A cluster is a group
of more than two sectors. Cluster sizes can vary from 512 bytes to 256k
bytes, depending on the particular file system and the partition size.

CROSS-LINKED FILES

If your system crashed while you're saving a file, the FAT may report that two
files contain at least one like cluster on the drive. These are cross-linked files.
These are not allowed by either FAT or NTFS file systems. NT does support
hardlinks and they will not be described as cross-links. A hardlink is simply
another name (possibly in another folder) that contains exactly the same
contents.

FILE ALLOCATION TABLE

In DOS and Windows, data is stored in distinct clusters on the drive. DOS
creates a File Allocation Table (FAT) to track where each file is stored.

FILE SYSTEM

A file system consists of files, directories, and the information needed to
locate and access these items. File systems are generally specific to the type of
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computer you have. Most IBM-compatible personal computers use the File
Allocation Table file system in one form or another.

HARD DRIVE

The piece of hardware in your computer that stores all the files that your
computer uses. Hard drives typically use several encoded disks to store this
information. Drives can be divided into several partitions for more efficient
storage.

PARTITION

A section of your hard drive formatted for use by a particular file system.
Drives formatted by DOS or Windows have at least one partition, labeled C:.
Large drives can be formatted to have multiple partitions. Each partition will
then behave as if it were a separate physical drive, with its own letter (D, E, F,
etc.).

SECTOR

The smallest storage allocation units on a hard disk drive. Typically, on PCs,
a sector holds 512 bytes of information.
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